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SISSEJUHATUS

2005. aastal ostis Adobe &ra Macromedia — Uhe rmaugraafika ja veebiarendusega
tegeleva firmgAdobe.com. 2005)Selle ostuga sai Adobe endale suure osa arvutiigaaaf
turust ning paris algsed Macromedia projektid n&dmsh, Dreamweaver ja Fireworks.
Koik kolm programmi on hetkel juhtivatel kohtadelaailmas nii veebigraafikas kui

veebiarenduses. Hetkel on levinuim tarkvara veeahitka loomiseks Adobe Fireworks.
Kuid on disainereid, kes eelistavad oma veebilehtedementide loomisel Adobe

Photoshoppi Fireworksile seetdttu, et Photohop raaftka loomisel ja to6tlemisel mdneti

paindlikum. Photoshop oli algselt loodud fotode ti&@iseks, kuid ajapikku on ta

kasutusvaldkond korduvalt laienenud. Algselt ilmdghotoshop koos laiendusega
Imageready, mis oli mdeldud lihtsamate veebi jaiagvaafikaelementide loomiseks. Kuid
hiljem alates Adobe CS3st integreeriti see taidiRhhotoshoppi.

TOO eesmark:

Tutvustada Adobe CS4 paketiga kokku puutunud éastitajale Photoshopi kasutamist

veebigraafika loomisel.
Ulesanded:
e Tutvustada Adobe Photoshop CS4 kasutamist veelfiiggdaomisel;

e Tutvustatud tooriistu kasutades luuakse veebil&degiBne disain (mocup).

TOO jaotatakse kaheks osaks — esimeses osas aibks®t programmi seadistamist
erinevaid to0riistu ja nende kasutamist ning tédete osas luuakse neid todriistu kasutades

veebilehe staatiline disain (mocup).



Kindlasti ei ole Photoshop CS4 kasutamisel valjadavad meetodid ainudiged, vaid

kajastavad autori viisi probleemide lahendamiseks.
I. TOOKESKKONNA TUTVUSTAMINE

1.1. Adobe Photoshopi kasutamisvéimalused

Adobe Photoshop on Adobe firma ks lipulaevu gkaafiostuses. Algselt oli tegu ainult
fotode tootlemiseks mobeldud tarkvaraga, kuid |4jai an saanud Photoshopist risttee
koikide arvutigraafika ttlpide jaoks. Photoshopisga uue versiooniga juurde tulnud uusi
rakendusi. Viimases valjalaskes uuendati nditeksalimesmootorit. Photoshop on

rastergraaafika kdrvalt vbimeline looma pohiliskigrgraafika elemente ning algelist 3D
graafikat, millele lisavad funktsionaalsust eriad\isarakendused (plug-in). Lisaks sellele
on Adobe CS seerias (Creative Suite) ilmuvad progral sama seerianumbri sees

taielikult thilduvad, ehk todmuster (ingl workflowh taielikult kasutaja enda otsustada.

Kasutaja saab oma t66 protsessi kohandada vastamaltoskustele ja teadmistele. Adobe
CS paketis on kbik programmid Uksteise vahel Ukidl) mis tdhendab et kasutaja saab
avada Uhe programmiga teise programmi faile va e&sportida Gldtuntud formaatidesse.
NOnda saab kasutaja leida enda jaoks kiireima gayktiivseima tee oma Ulesannete
taitmiseks. Naiteks loob kasutaja vektorgraafilkanendid Adobe lllustratoris ja impordib

need Photoshopis kasutamiseks .PSD failiformadim¥lusi on palju.

1.2. Veebigraafika veebidisainis

Veebigraafika on veebidisaini osa, mille tahtsusreb kasutajaga visuaalsel suhtlemisel,
voimendades kasutajas kindlat emotsiooni, tedaadipst voi suunates millegi poole. Hea
disain omab veebilehe eesmargi jaoks suurt tédhtsesparast kasutatakse veebigraafika
loomisel kdikvoimalikke materjale nagu fotod, vekp@afika, pixelart, joonistused ja
tekstuurid. Neid omavahel sobivalt kombineeridesutatakse veebilehe sisu. (W3.org,

Graphics).



1.3. Todlaua seadistamine

Enne t60 alustamist tuleb seadistada t66laud valstamna vajadustele. Selleks saab avada

dialoogiakna valikuga File menud > New (joonis 1.1)

New
Marne: IUntitIed—l Ok I
~ PBreset; I Custom j i Cancel |
Size: I ;] Save Preset... |
Width: | 300 [ pixels | Delete Breset,.,
Height: [300 [ piets | _
Device Central... |
Resolution: |?2 I pixelsfinch LI
Calor Mode: I RGE Color LI | & bit j
Background Contents: I Transparent ;I i
¥ Advanced - - 263,7K

Joonis 1.1Photoshopi dokumendi seadistamine

Name — Nimi, selle vGib projekti alustades esialgu tépanuta jatta. Hiljem salvestades

saab nime vajadusel muuta.
Width, Height — Laius, kbérgus, m&aratakse vastavalt elementid#meiele.

Resolution— Resolutsioon (antud kontekstis mitte segi ajad@tmetega - laius, kdrgus).

Resolutsiooni vaartust vaidlustatakse seetttuergdllikad soovitavad kasutada erinevaid
vaartusi. Hetke standard on 72dpi (ingl dots peh)nUsna levinud on ka 96dpi, kuna
enamus monitore kuvavad pilti just sellises suwsuSeiuremad dpi (300dpi) vaartused on

soovitatavad kui luuakse graafikat printimiseks.

Color Mode - Color Mode kirjeldab viisi kuidas varvid genettakse. Kuna
arvutigraafika ja DTV hetkestandard on sRGB/(stadd®GB) (M.Stokes. 1996.a.), siis on



ainudige valik RGB varvid (sSRGB lisasate ,Advancéidapaneeli alt on vaikimisi seatud).

CYMK varvid on rangelt printimise tarbeks.

Background Contents— Kasutaja saab valida, kas ta soovib luua totdewn@rvilist voi
l[&bipaistvat tausta. Antud néidisel on see maanzsigaistvaks (ingl Transparent), et oleks
mugavam teha t66d .PNG (ingl portable network gieghfailiformaadiga. Kui element
salvestatakse siiski tahtlikult .JPEG (ingl joinhopographic expert group) formaati
taidetakse koik labipaistev automaatselt varvigégs on vaikimisi valge. Tuleb meeles
pidada, et rastergraafika failid on ristkuliku kiged, mistttu logodele lisatakse .JPEG

formaati salvestamise korral mittevajalikud valgenigad.

1.4. Problemaatiline to6laud

Vahel juhtub, et moni vajalik sate jaab todlauadsgamise etapil kahe silma vahele. Et
juba tehtud t60 kaotsi ei laheks, on vbimalik tébdlaualt parandusi, mis kooskolastavad

t606 nduetega.

Valed vérvid — Kui alustate oma t66d CYMK varvidega, siis kimeparandus on (joonis

1.2) Image menll > Adjustments > Mode.



Layer Select Filter  Analysic 300 Wiew Wi

Biriap

Grayscale
Adjustments r SR
Auto Tone Shift-itrHL Indesced Colar. .,
Auto Conkrast alb+Shift+Ctr+HL v RGE Color
Auta Color Shife+Ctr+E MY Color
Lab Color
Image Size:.. Ale+Cerl+1 Multichanril
Canvas Size... Alt+Chrl+C
Image Rotation » & 8 Bits/Channel
Crop 16 Bits/Channel
Trim. .. 32 Bits{Channel
Reveal Al Color Table..
Doplicate. .,
apply Image: ..
Calculations...
Yariables 4
Apply Data Sek..
Trap.

Joonis 1.2Dokumendi varvisatete parandamine

Seda etappi taites kusib programm, kas soovitaksed kkokku sulatada (ingl
Merge/Flatten). Seda on mdistlik valtida, et s&ilit66 dunaamilisus ning vajaduste

muutudes oleks lihtsam faili muuta.

Vale resolutsioon— Kui alustate oma t60d tarbetult suure resolotsga (ca 97dpi ja
rohkem) siis on sobivaim viis seda korrigeeridaiktegja Image menud > Image size.
Seejuures tuleb kindel olla, et Resample Image kiweast on linnukene ara voetud,

vastasel juhul muudetakse vordeliselt ka loodagmehdi pikkust ja laiust (joonis 1.3).



Image Size B2

— Pixel Dimensions: 2,93M
width: 1280 pizels s |
Height: 200 pixels R I

— Document Size:

width: [45,16 [[em izl
|

Height: | 28,22 [cm =~
Resolution: Iﬁ | pixelsfinch j

[ Scale Styles
¥ Constrain Proportions
[~ Resample Image:

|B|-:uhic (best for smooth oradients) j

Joonis 1.3Dokumendi resolutsiooni parandamine

Taidetud Background Content — Photoshopi iiks p6himotetest on, et alati peamas
olema vahemalt Uks kiht (ingl Layer). Lahenduslksgisneb selles, et luuakse uus tihi kiht
ja all olev taidetud tausta kiht kustutatakse &eae on tehtav ,Kihtide menuust” (ingl

Layer menu), mis on vaikimisi kuvatud ekraani @ftgmas nurgas (joonis 1.4).

Kustutamisega kaasneb olukord, mis valistab momengafektide ja/voi filtrite
funktsionaalsuse vdi kasutamise taielikult (efeffilitid, mis nBuavad kindlalt originaalse

background kihi olemasolu).



LAYERS |[[EHANS

INnrrnal ;I Dpacikyt | 100% | b
Lack: [4 & @ Fills | {005 |

| Delete layer

||__:||__L||j;] |E:| : & T R

Joonis 1.4Varvilise kihi kustutamine kihtide menutist

1.5. Todriistade tutvustamine

Photoshopis on toériistad erinevate tooulesanrsetks) Aja voitmise tarbeks on peaaegu
igal todriistal oma kiirklahv(id), et saaks Kiirddige tooriista valida. Kiirklahve peaksid

teadma koik sdltumata Ulesandest (tabel 1.1).

Tabel 1.1Kiirklahvid

Kasklus Funktsioon

\Y, Move Tool vbimaldab objekte selekteerida ja miskferida.

B Brush. Maalimispintsel

E Ereaser. Kustutuskumm.

G Paint Bucket, Gradient Tool. Varviamber ja Gratligdoriist.
SHIFT + G vahetab Paint Bucketi ja Gradienti vahel

X Vahetab &ra varvipaletil pohi- ja taustvarvi.
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Kasklus Funktsioon

D Laeb varvipaletil vaikimisivarvid, musta ja valge

CTRL+ Z Undo, votab Uhe tehtud kasu tagasi. Terskk®l vajutamise
taastab tehtud kasu.

CTRL+ALT+Z Undo, votab niipalju k&ske tagasi kui jgdoo paneelis® (ing

History Panel) neid séailinud on.

ALT + Backspace Katab terve kihi vdi selektsioo@hjvarviga.

CTRL + Backspace Katab terve kihi vdi selektsioglatuses taustvarviga.

1.6. Kihtide menu

Tark ei ole hoida oma t66 elemente Uhel kihil, sasutmisvajaduse korral peate olema
valmis kihi osaliseks voi taielikuks kustustamisegelle valtimiseks on soovitatav hoida
elemente eri kihtidel. Just selle jaoks on olemigtide menidd“ (ingl Layer Panel).

,Kihtide menuu* on peamine navigeerimisvahend P&lotpis, mis asub ekraani all
paremas nurgas (joonis 1.5).

[CHANNELS, | PATHS
!Normal ;IOpacity: 100% | *

Lock: [ & +b @ Fill: n

Q I:l kit 2
B I:l Kiht 1
-iﬁi I:l Eathgroumnd 5 |

= F O e O 5 9

Joonis 1.5Kihtide menud.
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1.7. Kihtide menui kiirklahvid

Kihte mogjutavaid kiirklahve kasutatakse, et voimata oma dokumendis orienteerumist.

Tihti tekib dokumenti palju erinevaid kihte ja nedhavahel Glhendades ning grupeerides

on vBimalik muuta t60s navigeerimine palju mugavisn@abel 1.2).

Tabel 1.2Menuile rakenduvad kiirklahvid

Késklus Funktsioon

CTRL + SHIFT + N| Loob uue kihi, avab dialoogiakna.

CTRL+J Loob kihist koopia.

CTRL+E Merge Layer(s) Uhendab omavahel kaks wane selekteeritud kiht
Uheks kihiks. Soovitatav on selekteerida Uhendatdshid hiirega
hoides all CTRL nuppu. Vaikimisi Uhendab kaskluditud kihi ja
otse selle all oleva kihi.

CTRL+G Group Layers loob selekteeritud kihtideks alamkausta kuhu neg

kihid paigutatakse. Vaga kasulik on see mitmestiskiltoodud

keeruliemate elementide haldamiseks.

od

ALT + Lohistad
hiirega kihti/objekti
kihil

Teeb kihist/ objektist duplikaadi.

1.8. Kihtide menuu funktsioonid

Tabel 1.3Kihtide menud pdhifunktsioonid

Kihtide menid Glaosas paiknevad nupud

Eesti keelne Inglise keelne | Pilt/lkoon Funktsioon
nimetus nimetus
Kokkusobitamine| Blend Modes | [marrmal | Erinevaid algoritme

12

kasutades saab kihi  kokku



sobitada alloleva kihiga vi
kihtidega.

Kihi labipaistvus | Opacity Opacity: | 100% | r| Saab modjutada kogu kihi
l&bipaistvust. Seehulgas
vahendada ka kihile
rakendatud efektide
l&bipaistvust.

Kihi taide Fill Fills n Saab mojutada vaid objekii,
mitte  sellele  rakendatud
efekte (ingl Blending
Options).

Lukustusmenit Lock Lock: [] &+ @ Voimaldab kihte erinevalt
lukustada.

Kihtide menid allosas paiknevad nupud

Eesti keelne Inglise keelne | Pilt/ Funktsioon
nimetus nimetus Ikoon
Kihtide Link Layers == | Vdimaldab Iuua kahe kihi vahel seose
linkimine Uksteise suhtes paiknemise kohta. Hea
kasutada kui on vahe kihte.
Kihi efektid Blending f=_ | Kiirnupp véimaldab ligipdasu erinevatele
options efektidele.
Eesti keelne Inglise keelne | Pilt/ Funktsioon
nimetus nimetus Ikoon
Kihi mask Layer mask 0] | Kiirnupp vBimaldab luua selekteeritud kihilg
»Kihi maski®.
Kohanduskiht Adjustment #,_ | Voimaldab rakendada kihtidele kiirelt ja
Layer dunaamiliselt (muudatusi saab tagasi votta

funktsioone, mis avanevad Image menui >

Adjustments alt.
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Kihtide Group Layers | 1 Voimaldab grupeerida selekteeritud kihid.

grupeerimine Sarnane funktsioon nagu Link Layers, kuid
suunitletud rohkemate kihtide haldamisele.

Uus kiht New Layer 1] Voimaldab luua uue kihi selekteeritud kihi
kohale.

Kihi Delete Layer ol Voimaldab kustutada selekteeritud kihi(d).

kustutamine

1.9. Kokkusobitamine

Kokkusobitamine (ingl Blend Modes) on vaieldavaltoRbshopi kdige voimsam tooriist.

Blendimine m

heleduse ja/v0

uudab kihtide kaitumist Uksteise suhfebel 1.4). Selleks kasutatakse

i tumeduse vaartuste modifitseeritaiste kihtide suhtes.

Tabel 1.4Kokkusobitamise funktsioonid (ingl Blend Modes)

Funktsiooni

nimi

Efekt

Normaalfunktsioonid

Normal Kuvab kihi ilma moonutusteta. Labipaistmatun

Dissolve Kuvab kihi pikselhaaval, labipaistvuspestsmaarab kui palju piksleid
kuvatakse.

Tumendusfunktsioonid

Darken Valib Glemise kihi kdige tumedama piksliuAdise kihi pikslid, mis or
heledamad kui valitud tumedam piksel tumendatalilegaanud toonid
jddvad muutmata.

Multiply Valib Ulemise kihi kdige tumedama piksliumendab alumise kihi koiki

piksleid valitud tooni vdrra. Kui valitud toon onust, siis tulemuseks o

must varv, kui valitud toon on valge, siis tumendsrai toimu.
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Color Burn Tumendab aluskihi pikslit suurendadesipese kihi piksli kontrastsus
Kui pealmine piksel on valge, siis muutust ei toimu
Linear Burn | Tumendab aluskihi pikslit vahendadealpése kihi piksli heledust. Ku

pealmine piksel on valge, siis muutust ei toimu.

Darker Color

Algoritm asendab halltoonist 50% hal®dd pikslid pealmise piks

varvusega.

Helendusfunktsioonid

Lighten

[11H

Vastupidine efekt vorreldes ,Darken

heledama piksli. Alumise kihi kdik pikslid, mis cmmmedamad, ku

valitud heledam piksel helendatakse, tlejaanudigikgvad muutmata.

igaalb pealmise kihi kdige

Screen

Vastupidine efekt vorreldes ,Multiply
heledama piksli. Helendab ko&iki alumise kihi pikdlevalitud tooni
vorra. Kui valitud toon on valge, siis tulemuseks walge vérv, ku

valitud toon on must, siis helendamist ei toimu.

ga.ahb pealmise kihi kdige

Color Dodge

Vastupidine efekt vorreldes ,Color Btiga. Kontrollib pildi iga
kanalit (ingl Channels — RGB/NTSC) ja helendab asinpikslit
suurendades pealmise kihi varvide kontrastsust.p€aimine piksel of

must, Siis muutust ei toimul.

Linear Dodge
(Add)

Vastupidine efekt vdrreldes ,Linear Burn“iga. Koolib pildi iga

kanalit (ingl Channels — RGB/NTSC) ja helendab alumist Igik

suurendandes pealmise piksli varvi heledust. Klmpae piksel orn

must, siis muutust ei toimul.

Lighter Color

Vastupidineefekt vorreldes ,Darken Color*iga. Algoritm asend

halltoonist 50% tumedamad pikslid pealmise pikéliwisega.

Kontrastsusfunkstioonid

Overlay

Algoritm on Multiply ja Screen algoritmidestand. Algoritm rakenda
kas Multiply vdi Screen algoritmi sdltuvalt aluraigiksli toonist.

Kokkusobitatav kiht katab alloleva kihi oma varviggaamal aja
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sdilitades alloleva kihi valguse ja varju. Alumigisli varv ei kao ara

vaid seguneb ulemise piksliga.

Soft Light

Algoritm kas tumendab vo6i helendab alsenipiksli varvi, soltuvalt
pealmise piksli varvi vaartustest. Kui pealmisespilheledus on 50%

halltoonist heledam, siis piksel tehakse heledani@ksor Dodge), ku

—

see on 50% halltoonist tumedam, siis piksel tehaksedamaks (Colg

Burn). Kui pealolev piksel on kas must voi valgies tulemuseks ei ol

D

puhas must ega valge, vaid tumedamad voi heledaéraatl.

Hard Light

Algoritm kas tumendab vo6i helendab alsingikslit, s6ltuvalt pealmis

(1]

piksli vaartustest. Kui pealmise kihi piksli heledan 50% halltoonist

—+

heledam, siis piksel tehakse heledamaks (Screanyeke on halltoonis
50% tumedam, siis piksel tehakse tumedamaks (MyltiKui pealolev

kiht on kas must voi valge, siis tulemuseks eipldas must vdi valge

vaid tumedamad vdi heledamad varvid. Kui pealnkité on must voi

valge, siis tulemus on samuti must vai valge.

Vivid Light

Algoritm kas tumendab v&i helendab dtirs pikslit, s6ltuvalt pealmise
piksli vaartustest. Kui pealmise kihi piksli heledan halltoonist 50%
heledam, siis piksel tehakse heledamaks (Screenhdtltoonist 50%

tumedam, siis piksel tehakse tumedamaks (Multipki pealolev

piksel on kas must vdi valge, siis tulemuseks ei plihas must v

valge, vaid tumedamad vdi heledamad varvid.

Linear Light

Algoritm helendab v6i tumendab pikditstes voi langetades alumise
piksli heledust séltuvalt pealmise piksli vaartuségii pealmise piksl

vaartus on 50% halltoonist heledam, siis alumigsli helendatakse

D

suurendades heledust. Kui tlemine piksel on hallgidc0% tumedarn,

siis alumist pikslit tumendatakse.

Pin Light

Algoritm asendab alumise kihi piksli vgrpealmise piksli varviga. Ku

pealmine piksel on halltoonist 50% heledam siissdk mis on

heledamad kui pealmine piksel asendatakse. Tumetlajaavad

16



puutumata. Kui pealmine piksel on halltoonist 5@medam, siis

U

allolevad pikslid mis on tumedamad kui Ulemine plkasendatakse.

Heledamad jaavad puutumata.

Hard Mix

Algoritm liidab pealmise piksli RGB vaaded alloleva piksli omale.

Kui tekkiva summa (iga RGB kanali kohta) vaartus2%b voi enam
siis saab piksli kanal omale vaartuse 255. Kui sanom alla 255 saap
piksel omale vaartuseks 0. NOnda taandub pikslivugir tiheks

algvarvuseks.

Vordlusfunkts

ioonid

Difference

Algoritm vordleb pealmise ja alumiseikikslite kanaleid (Channels -
RGB/NTSC) ja lahutab kas ulemisest pikslist alunvge vastupidi.
Soltuvalt kumba kihi piksli heledus on suurem. keialmine piksel on
valge, siis tulemus on vastandvarv. Kui pealmin&sgi on must

tulemust ndha ei ole.

Exclusion

Efekt sarnaneb ,Difference“iga, kuid diiksema kontrastsusega.

Komposiit e. Liitfunktsioonid

UJ

Hue Algoritmi  tulemus on pealoleva piksli varvus.llodeva piksli
valgustihedus ja erksus sdilivad.

Saturation Algoritmi tulemuseks on uus varv, missagunenud pealoleva piks
tooniga. Alumise piksli valgustinedus ja varvitossilivad.

Color Algoritmi tulemus on pealoleva piksli varvjaserksugsaturation) ning
alloleva piksli valgustiheduse. Sarnane ,Hue“ dafektkuid palju
erksam.

Luminosity Algoritmi tulemuseks on uus varv, mis segunenud pealoleva piks

tooniga. Alumise piksli valgustinedus ja varvitosdilivad
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1.10. Kihi kompositsioonid

Kihi kompositsioonid (ingl Layer Comp) on kasuli&driist erinevate kompostitsioonide

sailitamiseks. Menii to6tab sarnaselt Kihtide méniKihi kompositsioonid suudab jatta

meelde objektide paigutuse kdrval ka kihtideletiisiefektid.

Kasutaja loob uue kompositsiooni kihi, milles tago#iab objektid oma vajaduste jargi.

Meniiu on leitav Windows > Layer Comps (joonis 1.6).

LAYER COMPS [BINGE

ES

B | 1 st Document State

= | Laiver Comp 1

E Layer Comp 2

< P

@ & o

=

Joonis 1.6Kihi kompositsioonide mentu

Tabel 1.5Kihi kompositsioonide menti allosas paiknevad @upu

Eesti keelne Inglise keelne | Pilt/ Funktsioon

nimetus nimetus Ikoon

Eelmine/Jargmine | Prevoius/Next| «l = | Vahetab kompositsioonide vahel.

kompositsioon Comp Mitte vaga olulised nupud.

Varskenda Refresh [, Uuendab kompositsooni ja
muudatusi.

Uus kompositsioon New Comp al Loob uue kompositsiooni.

Kustuta Delete Comp i Kustutab selekteeritud

kompositsioon

kompositsiooni.
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1.11. Kihi efektid

Kihi efektid (ingl Blend Options) leiab kihtide méi jalusest (vasakult teine ikc ﬁ:,)_
Teine vOimalus on vajutada muuta soovitavale kihiliee parempoolse klahviga. [Imub
mendd, mille Glaosas on ,Blend Options* ning kilole vdimalik lisada kiirelt efekte.

Kihi efektidega (ingl Blend Options) saab maaravgik kihi kokkusobitamist (ingl Blend

Mode) ning maarata kuidas kokkusobitamine mdjuthb tkisi elemente. Selle sektsiooni
suurim joud seisneb ,Blend If* funktsioonis (joordis7), millega on vaga mugav peita kihi
tumedaid vdi heledaid osi. Selle saab panna remgeeka varvidele. Efekt sarnaneb

.Multiply Blend Mode’ile”, kuid efekti tle on kasatal taielik kontroll.

Layer Style .
Shyles — Blending Options
| — General Blending
Blending Options: Custom Elend Made: IN | ;] Cancel |

=4 ' Marma
r Prop Shadow Opaciby! — rm_ ko Ney Style. i I

™ Inrer Shadow

— Advanced Blending
Eill Opacity) e— oy [ 100 %
Chanmelz: W R WG WE

¥ Preview
™ Cuter Glow & £

™ Inner Glow

I™ Bewel and Emboss Knockout: INone vl
™ Contour [~ Blend Interior Effects as Group

[ Elend Clipped Layers az Group

I~ Texture
3 v Transparency Shapes Laver
I Satin [~ Lawer Mask Hides Effects
™ Colar Swerlay [~ Yector Mask Hides Effects

[T Gradient Cwerlay — BlendIF [5 =
&l ' |Gray

I Pattern Corerlay
This Layer: 24 74 255

L E—
d & fii
Urdetlying Layer: ] 174 f 214
Y il i

Joonis 1.7,Blend Options* ja, Blend If* funktsioon

.Blend If* sketsioonis olevad kaks sliderit mojutalskdesoleva kihi kuju kasutades selleks
kas kaesoleval voi alloleval kihil leiduvaid varwarvimuutused on Usna teravad, kuid

neid on vOimalik hajutada. ALT nuppu all hoidessjaerit lahku tdmmates (poolitades)
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luuakse toonide vahemik milles hajutamine asebl§@onis 1.8).

Joonis 1.8 Blend If funktsiooni naide

Kihi efektide (Blend Options) juures (tabel 1.5pks&kasutaja mééarata kokkusobitamiseks
(Blend Mode) algoritme (tabel 1.4), et efekte oneladukamalt integreerida (joonis 1.9).

Tabel 1.6Kihi efektid (Blend Options)

Efekti nimi Funktsioon

Drop Shadow Heidab objekti taha varju.

Inner Shadow Heidab varju objekti enda sisse.
Outer Glow Loob objekti Umbritseva kuma.
Inner Glow Loob objekti sisse kuma.

Bevel and Emboss| Loob kerge kolmemddtmelisuseiefekt

Satin Loob sarnase efekti kdevel and Embos&obib rohkem kandilist

[{%)

vormide jaoks.

Gradient Overlay Katab objekti kogumahus kasuta@tpmaaratudsradientiga

Color Overlay Katab  objekti  kogumahus  kasutaja  poolmé&éaratud

monokromaatilise varviga.

Pattern Overlay Katab objekti kogumahus kasuta@tpoddratud mustriga.

Stroke Loob objekti kontuure jargides uue piirjoone
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LAYERS ST AcTin) =

INorrnaI _dOpacity: 10095 | ®
Lock: ] #+ @ Fill: n

B Inner Glow

® EBevel and Emboss
& Color Corerlay

= Gradient O\re.rlay

L] _P_;a-t-t-em (S\rer-l-a-y

Joonis 1.9Nupuke, mis on loodud kera sisse (I6ikemask) kamsg&ihi efekte (Blending
Options)

Lisafunktisonaalsuse saavutamiseks on voimalik udoefekte eksportida eraldi kihtidele.

Iga kasutatud efekti tarbeks luuakse eraldi uud. kBee lisab t6dle dinaamilisust

vOimaldades rakendada erinevaid to0riistu, mis mnypdleks kattesaadavad (Kihi mask,

Loike mask jm).

Sellele saab ligi vajutades hiire parema klahvideék rakendatud efektide peal ja valides
,Create Layer”. Teatatakse, et efektid ei ole emimaamilised ja automaatselt luuakse iga
efekti kohta eraldi kiht.

1.12. Kihi mask

Kihi mask (ingl Layer Mask) on tddriist, mida saedkendada igale kihile eraldi ja mis
mojutab ainult selle kihi valjanagemist (joonis @).1Selle kasutamise kasulikkus seisneb
selles, et objekti osi saab peita ilma neid tegélikaotamata ja see muudab disainit66

dinaamilisemaks. Alati saab muutusi sisse viiagasi votta.

Kihi mask to6tab halltoone lugedes (ingl Grayscalgge tahendab, et mask reageerib vaid
valgele ja mustale ning hallidele toonidele. Muatwpeidab ja valge néaitab. Halltoonid
loovad labipaistvuse. Mustvalggadienti kasutamine lubab luua vaga huvitavaid efekte

ning toetab sujuvat tleminekut thelt varvilt tegsel 6driistale paaseb ligi Layer mentist
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paremal all nurgas (joonis 1.10).

LAYERS | CHANNELS: | PATHS
[ armal | Opacity:
Lock: [] & & & Fill: | 1006 | * |

|'§ [ I:I Fackground &

= fx 0O/@® 3 & 3

Joonis 1.10Kihi maski ikoon kihtide menuus

A
\

Joonis 1.11Kihi mask rakendatuna (vt pilt 1.10)

1.13. Loike mask

Loike maski (ingl Clipping mask) kasutakase pilteetamiseks konteineritesse. Konteiner
vOib olla mistahes element - geomeetriline kujuiodit voi ebakorrapdrase kujuga objekt
(joonis 1.12). Praktikas on see hea vahend b&enentippude ja muude sarnaste
elementide loomisel (tabel 1.6). Ndutud on, et kibjeida soovitakse asetada objekti sisse

asub ,Kihtide menuus" jarjestuselt konteinerinatka kihi peal (joonis 1.12).
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Tabel 1.7Kiirklahvid

Kasklus

Funktsioon

ALT + CTRL+ G

Asetab objekti alloleva objekti ses¢Ldike mask)

Allolev objekt kaitub konteinerina.

ALT (hoida all) + Hiire klops
vasaku klahviga (Kihtide menuis

Selekteerib kihi, mida soovitakse konteinerisse

asetada, seejarel tuleb hoida all ALT nuppu
klikkida allolevale kihile (peab ilmuma kindel

LAYERS [IEH

Opacity I 100% | »
Lock: [ o+ @ Fill: n

a Layer 1
= 8 Shape 1
.—z :ﬁ D s

|§ Fackground’ 5|

INormaI

= fx O ®© L & 3

Joonis 1.12L.6ike maski ikoon kihtide mentils

Joonis 1.13L6ike mask rakendatuna (vt joonis 1.12)
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1.14. Kontekstitundlik skaleerimine

Klassikalised skaleerimisvahendid (ingl Content-Aev&cale) nagu Scale, Skew jt olid
olemas juba Photoshopi alguses, kuid see on uuemsisuli sisse alates CS4st. Rakendus
suudab objekti sisust mingil maaral aru saadagiibevahendada pildi fatsilisi mddtmeid.
llIma pildil olevate objektide proportsioone muutmaurutakse sarnase varviga piksleid
kokku.

Kiirklahv CTRL + SHIFT + ALT + C kaivitab selekteeritud kihKontekstitundliku
skaleerimise. Tegu on v8imsa vahendiga, kuid digorimida see taidab pole veel taiesti
padev. Kergelt tekib pildile artefakte. Selle tddaga saab luua hdlpsalt fotode alusel

bannereid jpm (joonis 1.14). Parast skaleerim@@b fotol ndha, et kohal kus pilved on

kontaktis kaljudega on tekkinud margatavaid moosiufoonis 1.14. pilt 2).

Joonis 1.14Foto enne skaleerimist (1) ja parast skaleerir@ist (
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1.15. Trikkimine

Trukkimine (ingl Type Tool) onPhotoshopis eksisteeriv trikkimistooriist. Veebadhis on
see vajalik vaid juhul, kui luuakse erilisi nupukegeebilehel navigeerimiseks voi
illustreerival eesmargil. Tekst luuakse vektorgileafa, mis tdhendab, et kuju luuakse
matemaatiliste algoritmide alusel. Vastupidiset teapaafikale on kuju pidevalt
kdrgeresolutsiooniline. Tekstile saab maarata esitk atribuute suuruse ja kirjastiili
korvalt (nt. Blend Modes, Warped Text).

Tabel 1.8Kiirklahvid

Kasklus Funktsioon

T Trukkimistooriist.

SHIFT + T (Type Tool selekteeritud) Muudab kirjutamorientatsiooni, vahetab

tooriista variatsioonide vahel.

Trikkimist (ingl Type Tool) saab kasutada kahte dip&as lihtsalt klikkides soovitud
kohal ja trikkima asudes (Point-Text) vbi vedadésed@ ala, mida kasutatakse teksti

mahutamiseks (Paraghaph Text).

1.16. Geomeetrilised kujundid

Geomeetrilised kujundid genereeritakse vektorgkaaf. Nende pohiline funktsioon
veebigraafika loomisel on erinevate konteinerite ganeelide loomine, mille sisse
asetatakse info ja/voi pilt (LGike mask). Nendeadais veebidisainis on pohiliselt staatilise
disaini (mocup) jaoks, kuna enamiku geomeetriastb sgenereerida veebilehe koodi

kirjutades (div’id jms).
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Tabel 1.9Kiirklahvid

Kasklus Funktsioon

U .,Rectangle Tool"

U + SHIFT (Rectangle Vahetab ,Rectangle Tooli“ variatsioonide vahel.

Tool selekteeritud)

Skaleerides

SHIFT Sélitab elemendi proportsioonid ja skalesglekteeritud

nurga vastasnurgast valjapoole.

SHIFT + ALT | Sailitab proportsioonid ja skaleerib objekti teneskpunktist

skaleerimine

1.17. Disainimine

Esimene etapp disainimisel on veebilehe staatilisaini loomine (ingl mocup). Staatiline

disain tdhendab, et leht on pelgalt rastergraafdee on esimene visuaalne kujutis, mis
annab Kliendile ettekujutuse, milline veebileht kelix valja nagema. Kdige vaiksem
lubatud disaini laius on 760px, kuid tanapéeval emamasti kasutusel 975px laiad
veebilehe disainid, kdrgus soltub puhtalt leheldtavast sisust. Muidugi ei ole kohustuslik
seda nduet taita, kuid see tagab enamlevinud tsgmdnidel normaalse valjandgemise.

Kui staatiline disain on valmis ja kliendi poolt dies kiidetud algab lehe disaini
kokkupanemine. Disainer kasutab oma loodud stsiatdiisaini tikkide |dikamiseks.
Loigatakse valja kdik graafika, mille genereeringi@browserise toime ei tule, selle hulka

kaivad ka koik erilised fondid, mis ei ole veebisdilkud.
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2. TOO PRAKTILINE OSA

2.1. Veebilehe tehniline loomine

Kéesoleva t66 Uheks eesmargiks on veebilehe dikajundamise tehnilise osa dpetamine
kasutades Photoshoppi. Kasutades olemasolevaidjabateuakse selles naites veebileht,
mis sobib koduleheks kunstnikule (joonis 2.1).

Soovitatav on jargida juhist ning teha labi kdiknsaud, mis on dpetuses margitud. To0
I[6pus on tagasisidekiusimustik, milles saate valjaat tddga seotud arvamused ja

ettepanekud.

2.2. Veebilehe loomise etapid

Sodnastage veebilehe eesmark (mida pakub, sihtgnejpp
Tutvuge sarnaste veebilehtedega.
Tootage valja loogikaskeem (mis lingid veebilehel mille alt on info leitav jms).

Kujundage disain arvestades sihtgruppi ja teemat.

ok~ w0 bnp P

Pange leht kokku ja kirjutage kood.

2.3. Veebilehe kujundamisel kasutatud algmaterjalid

Tabel 2.1 Veebilehe loomisel kasutatud pildifailid

Faili nimi Originaalresolutsioon | Naidispilt
sein.jpg 4096 x 2048px
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Logo.jpg 522 x 520px
Morad.jpg 1522 x 897px
FB_logo.png 256 x 256px
twitter_logo.png 256 x 256px
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ross on the paberﬁo,r a reference paint, i put
tha character on.

And | did a litle "trial and errar test” just sat down near
: lha Iamp and E.\hcﬁ‘ths character from all the sides. tél
g allt

Joonis 2.1Photoshopi kasutamise I6pptulemusena valminud leebkujundus
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2.4. Veebilehe loomise juhend

2.4.1. Uue dokumendi loomine ja to0 tehniliste paraeetrite maaramine

Sammud uue dokumendi loomiseks ja t60 tehnilistarpaetrite maaramiseks:

1. File -> New (joonis 2.2);

2. ToO laius (width) - 975px (kujunduse laius peakenoh alati alla 1000px, et
enamlevinud resolutsioonidel oleks loodav disaimmaalselt kuvatav);

3. To66 korgus (height) - 800px (t66 kdrgus voib olerkidagi muud, kuid soovitatav
on vahemalt monitori kdrgus pikslites);

4. Resolution - 72dpi;

5. Color mode — RGB color;

6. Vajutage OK.

Color Mode: | RiGE Colar ;! I 8 bit

New x|
Marne: |Untitled-3 | Ok |
Freset, | Custorn j == Cancel |
Size | =l Save Praset.. |
width: 975 [ pixels =] Belete Freset,, |
il |E":|D| Ipi}{els j Device Central... |
Resolution: |?2 I pixels finch j
=
=

Eackground Contents; | Wihite )
Image Size;

¥ Advanced 2,23M

Joonis 2.2T60 tehniliste parameetrite maaramine
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2.4.2. Esimese tekstuuri importimine

Tekstuuri importmiseks tuleb l&bida jargmised samimu
1.
2.
3.

Avage tekstuuride kaustast fail “sein.jpg”;

Selekteerige pilt (CTRL+A vdi Select mentt -> All)

Kopeerige see (CTRL+C) ja kleepige (CTRL+V) asjadod dokumendi taustale.
Vahendame pildi mddtmeid nii, et see katab umb&sidkumendi pinnast.;

Tehke kihist koopia (Layer-> Duplicate Layer voi RO+J) ja peegeldage seda
(Edit-> Transformation tools-> Flip Vertically nirsgejarel Flip Horizontally).;

Vahendage pildi mddtmeid niipalju, et pilt katakehes 1/4 dokumendi pinnast.

Joonis 2.3Dokument parast teise ja kolmanda sammu labimist
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2.4.3. Taustakihi tegemine

Loome veebilehele tausta. Selleks looge uus kihTRIGFSHIFT+N). Tausta kihid
jarjestage tekstuuride alla (joonis 2.4) ning sej&arvige taust halliks (varvi kood

naidisel on #a8a8a8).

[ Layer 4

| :ﬁ Layer 1 copy

g E :ﬁ Layer 1
| D taust_hall

| Eackaround &

Joonis 2.4Tausta kihi asukoht

2.4.4. Kihi maski lisamine tekstuuridele

Kihi lisamiseks tekstuurile toimige jargmiselt:
1. Selekteerige ,Kihtide mentust* tekstuuri kiht jajwage ,Kihi maski“ nupule
(joonis 2.5);
2. Seejarel klikkige tekkinud maski peal (valge ruiys) valige tdoriistamenddst

[
,Gradient Tool" j= (joonis 2.6).

Tuleb kindel olla et “Gradient Tooli” funktsioon gmustast labipaistvaks” (kontrollitav

peamenti all oleval ribal, kui “Gradient Tool” oal¥ud (joonis 2.7)).
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5[ | (sosza

Joonis 2.5Kihi mask asub kihtide meni alaosas (ekraaniaakimas nurgas)

8 N F

Joonis 2.6, Kihi mask* kihtide mentiils

Joonis 2.7“Kihi mask” rakendatuna tekstuurile

Joonis 2.8Dokument parast neljanda sammu labimist
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2.4.5. Veebilehele logo lisamine

Veebilehele saab logo lisada toimides jargmiselt:

1.
2.

Layer style x|

Avage tekstuuride kaustast fail nimega ,logo.jpg"“.

Valige ,Magic Wand Tool* % ja selekteerige logo valge taust ning vajutage
CTRL + SHIFT + |, et selektsioon vastupidiseks teha.

Selektsioon tehtud ja aktiivne, kopeerige ja klgepisee oma dokumenti
(kopeerimine ja kleepimine - vaata etapp nr 2).

Tehke logo pilt vaiksemaks ja asetage endale meedge kohta.

Kihtide meniust vajutage logo kihi peale paremeehilahviga ja valige Blending
Options. Avaneb dialoogi aken (joonis 2.9).

Libistage alumise slaideri valget vaartust keskadole. See kustutab kaesoleva
logo kihi kohtadest kus alloleval kihil on helede@firtused. ALT klahvi all hoides
saab slaiderit poolitada, luues sujuvamaid tlemirgegoonis 2.10).

Shyles

Blending Options: Custom

™ Drop Shadow
I Inmer Shadow
™ Outer Glow
™ Inmer Glow

I™ Bevel and Emboss

— Blending Options

[ x 1]

— General BElending

Elend Maode: INormal j

(B T—— 1

— Advanced Blending

Fill Opacity! e [75 %
Charrels: W R WG B

Krochoout: INone vl

I™ Contour [ Elend Interior Effects as Group
™ Texture Iv Blend Clipped Layers a3 Group
ransparency Shapes Layer
. e Shapes L
I Satin [ Layer Mazk Hides Effects
I Calar Orverlay ﬂw\‘.’fﬂrﬂask Hides Effects
™ Gradient Cwverlay ﬂ'ﬁe’n’d I mf'a!‘ =
™ Pattern Overlay /
This Layer: ] 255
et ——
& &
Underlying Layer: ] 121/ 171
& d S

Cancel |
Mew Style: .. |

¥ Preview

Joonis 2.9,Blend If* sektsioon
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Joonis 2.10Logo pérast “Blend If” funktsiooni rakendamist

2.4.6. Pealkirja ja linkide loomine

1. Valige “Text Tool” T. ja kirjutage oma loodud lehele pealkiri. Valigeapdrjale
sobiv font ja kirja suurus.
Muutke teksti labipaistvamaks, et taustapilt nahgkiibi paistaks. (Opacity 70%).
3. “Blending Optionsi” dialoogiaknast tehke linnuke éBel and Embossi” ette, et
anda kirjale kerge 3D efekt. Vahendage efektidéphibtvuse (Opacity) vaartust
75% ni (joonis 2.11).

Layer Style i ll
Shles — Bevel and Emb oK I
— Structure
Elending ©ptions: Custom Thalat IPiIIow — vI Cancel |
L Teeiop stadcny Technique: ISmooth vl Mew Style. .. |

I Inner Shadow
Deptht grp—ou—-— |72 % ¥ Preview

Direction: {+ Up ™ Down
Sizel  — |5 px

I outer Glow

I Inrer Glow

[gl Bevel and Emboss Soften: — I 0 px
= e
Wl Texture:
= Angle: I o3 °
¥ Use Global Light
T Color Owerlay Alkibude: I 30 2
Gradient Owerla
[ L tloss Contour: m [T Anti-alizsed
I Pattern Owerlay
I Shroke Highlight Made: |Screen vl |

Opacity! ———y | 75 0

Shadow Mode: IMU|HD|V vl -

Opacityt - |75 %

Joonis 2.11“Bevel and Emboss” efekti satted
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4. Lisage kirjadele ka varju, et tuua neid rohkemeesiBlending Optionsi” all pange

linnuke Drop Shadow ette ja seadistage vastavaltidele (joonis 2.12).

X
Shyles — Drop Shadow ’T‘
— Structure - B
Elanding Options: Custom Elend Mode: IMuItipIy j - CanCéI |
S —— New Sieis |

I™ Irmer Shadow . & Rravics
I outer Slow Angle: ® IT 2 [T Use Global Light
™ Inner Glow Diztance: giy———— Ig_ px
¥ Bewvel and Emboss Spread: e—o o ID_ F

I™ Contour Sitel pe—o—w— [ px

I Texture — Quality
B ‘Contaur m [T anti-aliazed
T Colar Creerlay
™ Gradient Cverlay Maise! (i ID— £
I™ Pattern Cwerlay ¥ Lawer Knocks Qut Drop Shadow
™ stroke

Joonis 2.12Naidisel olevad Drop Shadow sétted

Joonis 2.13Dokument parast kuuenda sammu labimist
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2.4.7.

Efekti lisamine logole

1. Avage tekstuuride kaustast fail "moérad.jpg”.

Kopeerige ja kleepige tekstuur oma dokumenti jdamgetapselt logo kihi kohale,
nii "Kihtide mends”, kui ka pildi peal.

Maarake "Blend mode”iks "Screen” (see peidab arstawsa ja jatab alles ainult
valge osa). Looge "Loike mask”, selleks selektemrigkstuuri kiht ja vajutage

ALT+CTRL+G . Tekstuur on ntud asetatud logo sisse ja seelgi Ve logo kihi

aarte.

Joonis 2.14Dokumendi progress seitsmendat sammu jarel (Imé$esdl jooni mitte tahele

panna)

2.4.8.

Sisupaneelide loomine

Selles etapis on vaja kasutada juhtjooni. Selldatame esmalt, kas té6laual on joonlaud

nahtaval (joonis 2.), kui ei ole siis on joonlaeddv View > Rulers v6i CTRL + R.

Joonis 2.15Joonlaud (View-> Rulers ees peab olema linnuke)
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Méaéarake mdoodtuhikuteks pikslid. Mddtkava maaramistekde topeltkldps joonlaua peal.

Avaneb dialoogiaken, kus saate m&arata modtkagapKales voi pikslites. Valige pikslid.

1. Joonlaua ribast hiirega lohistades tdommake joonealalegi poole 50px sissepoole
dokumendi aartest (kahjuks ei ole tapset joonlau&@ha maaramist).
2. Seatud joonte vahele looge “Rounded Rectangle ig@oKastid (joonis 2.16).

| ] = [ ]FRectangle Tool I
i [} Rounded Rectangle Tool ]
C:J}‘ (3 Ellipse Tool 1
-
el

‘:3. Q Palygen Toaol Ll
";HI ™, Lin= Tool 1

A

Q\ .,-LF Custor Shape Tool

Joonis 2.16Rounded Rectangle Tool

2.4.9. Facebooki ja Twitteri logode lisamine “Kontti”

Avage “FB_logo.png” asetage logo kontaktipaneehdle ning kopeerige ja kleepige see
oma dokumenti. Korrake sama tegevust “Twitter_|pgg” jaoks.

2.4.10. Elementide véljaldikamine

Kujunduse valmides, tuleb vajalikud elemendid |fagadlja veebis kasutamise tarbeks.
Selleks kasutatakse .PNG laiendit. PNG (ingl Pdetalktwork graphics) on W3C standard
veebigraafikas. PNG on kadudeta pildifaili formaamjllel on eraldi alpha kanal

l&bipaistvusinfo jaoks. Veebilehel on vdimalik eksme Uksteise peale laduda kihtidena.

See vbimaldab luua keerulisi kujunduslahendusinj®a.20).
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1. Vedage juhtjooned Umber objekti. Valige todriidtatt “Crop Tooli” .EI: ja
tdbmmake objekti Umber juhtjoonte &arest kast. (Btmp kinnitab automaatselt
raamid juhtjoonte kilge). Vajutage Enter (joonis7.

2. NUUd on vaja peita ara koik uleliigsed kihid (Silrii(aongg kihtide menudist)
ja salvestada fail .PNG formaati. Kui see on tehtud objekt kasutatav
veebilehel.

3. Samamoodi tuleb kaituda kdigi loodud elementiddgga, pealkiri, lingid ja

taustaelemendid)

Joonis 2.17Juhtjooned on Umber objektide ja “Crop Tool’igajoonistatud kast objekti

Uumber

Bleg, GRS

Joonis 2.180bjektid parast valjaldikamist
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Mihkel Métas
mihkel@kuumeh
| (+372) 534371

Joonis 2.20Lehekdlje tldine disain on I6petatud ja valmishigaoks I6ikamiseks
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TOO KOKKUVOTE

Veebilehtede loomisel on selgelt eristatav ja khtdisain peaaegu alati kindel valik.
Seepérast on Adobe Fireworks hea just oma kindlaniduse poolest. Fireworks on
algajatele hea just seetdttu, et ta ei ole toadisga Ulekillastatud. Samas ei ole Fireworks
eraldiseisvana just kdige pilkuptiidvamate lahereliostja.

Photoshop on taielikult véimeline hea veebidisganigraafika loomiseks. Tal on olemas
kdik vajalikud tooriistad kiireks ja edukaks t6oRgaga laiad fototddtlusvéimalused on
head, kui tegu on lihtsa mentu voi taustapildi kdmmisega. Photoshop CS4 sisaldab
endas kindlasti kogu Adobe CS4 paketi hdid omadusg sobib siiski kbdige paremini
Uksikute elementide loomiseks ja vaheetappide iséks

Photoshop kindlasti jatkab arengut, muutudes tkieviveelgi vbimekamaks. Photoshopi
areng naitab meile, et Photoshopi kasutusvéimatugiirata, neid ainult laiendatakse.
Kaesolevas t66s tutvustatud materjali testiti katBshop CS5ga ja Opetused tootavad
kindasti ka edaspidistes Photoshopi versioonides.

Kaesoleva seminarit6d praktilist osa ei ole objek&é hinnangu saamiseks enne t60
kaitsmist kellelegi proovida antud. Opilased jaaasjnastajad, kes tunnevad veebidisaini
vastu huvi ning leiavad k&esoleva materjali intestdiles, saavad teha enda veebilehe
mocupi Erapooletu hinnangu saamiseks on koigil dppenadit&asutajatel voimalik t66
kaitsmise jarel anda hinnang t66 praktilise osauteamise kohta ning saata tagasiside

kisimustikus toodud e-posti aadressile.
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INFOALLIKAD

1. Adobe.com, Adobe To Acuire Macromedia (5.12.2805

URL - http://www.adobe.com/aboutadobe/invrelations/adobdeecromedia.html

2. W3.org, Graphics

URL - http://www.w3.org/standards/webdesign/graphics.html

3. M. Stokes, M. Anderson, S, Chandrasekar, R. &étiStandard Default Color Space
for the Internet — sRGB (5.11.1996.a.)

URL - http://www.w3.0rg/Graphics/Color/sRGB.html

4. N. Smith. Photoshop vs. Fireworks. (22.07.2008.a

http://www.digital-web.com/articles/photoshop vessfireworks/

5. Adobe Photoshop CS4 Help File

URL - http://help.adobe.com/en US/Photoshop/11.0/inden.ht
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LISAD

Lisa 1. Tagasisidekusimustik

Kasutajate arvamused ja ettepanekud t60 prakidsse kohta on oodatud 2011 aasta

[6puni. Taidetud tagasisidekisimustik saatke pakniressilenihkelmatas@gmail.com

1. Milliseks hindate dpetuse keerukust ?
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Lisa 2. Praktiliselt to6tav veebilehe vorm (Flash)

<?xml version="1.0" encoding="utf-8"?>
<mx:Application xmins:mx=" http://www.adobe.com/2006/mxml

layout=" absolute " backgroundColor=" #aB8aB8a8 " >
<!-- Efektid -->
<mx:Fade id=" helk " duration=" 100" alphaFrom=" 1.0 "alphaTo=" 0.8 "/>
<mx:Fade id=" helkAra " duration=" 100" alphaFrom=" 0.8 "alphaTo=" 1.0 "/>
<mx:Canvas id=" peapaneel2 "width=" 975" height="  100%"
horizontalCenter=" 0" backgroundColor=" #a8a8a8 " >
<mx:lmage id=" padis "top=" 0" left=" 0"
source=" @Embed(source='pildid/seinl.png") ">
<mx:lmage id=" jalus "bottom=" 0" left=" 0"
source=" @Embed(source='pildid/sein2.png’) ">
<mx:Image id=" logo "top=" 20" left=" 20"
source=" @Embed(source='pildid/logo.png") ">

<l--Menuu -->

<mx:HBox top=" 47" left=" 370" >

<mx:lmage id=" blog " source=" @Embed(source="pildid/blog.png")
rollOverEffect=" {helk } " rollOutEffect=" {helkara }" />

<mx:lmage id=" portfolio "
source=" @Embed(source="pildid/prtfolio.png") " rollOverEffect=" {helk }"
rollOutEffect=" {helkara }" />

<mx:lmage id=" contact "
source=" @Embed(source='pildid/contact.png’) " rollOverEffect=" {helk }"
rollOutEffect=" {helkara }" />

</mx:HBox>

<l-- Paneelid -->

<mx:Canvas id=" kontakt _panel "width=" 865" horizontalCenter=" 0"
bottom=" 10" borderStyle=" solid " height=" 50"
cornerRadius=" 8" borderThickness=" 2"
borderColor=" black " backgroundColor=" white "

backgroundAlpha=" 0.3 " >
<mx:lmage id=" FB"scaleX=" 0.15 "scaleY=" 0.15"

verticalCenter=" 0" source="  @Embed(source='pildid/FB_logo.png") "
rollOverEffect=" {helk } " rollOutEffect=" { helkara }" right=" 10" />
<mx:Image id=" TW scaleX=" 0.15 "scaleY=" 0.15"
verticalCenter=" 0" source=" @Embed(source="pildid/twitte_logo.png’) "
rollOverEffect=" {helk }" rollOutEffect=" { helkara }" right=" 50" />
</mx:Canvas>
<mx:Canvas id=" peapaneel "width=" 865" horizontalCenter=" 0"
borderStyle=" solid " top=" 170" bottom=" 80"
cornerRadius=" 8" borderThickness=" 2"
borderColor=" black " backgroundColor=" white "

backgroundAlpha=" 0.3 " />
</mx:Canvas>
</mx:Application>
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Veebilehe to6tav vorm on ehitatud kasutades Addée Builder 3e. Leht on sama hdlpsalt
kokkupandav kasutades HTML/CSS'i. Néidis ei olegedioptimaalsem lahendus kuidas
antud leht tles ehitada.

Lisa 3. MOningad Blend Modes’inaited

Modningad naitedlend Modes’erinevaid algoritme kasutades ja nende seletuss talkm

just selline on.

Joonis 1.Naidete selgitamisel kasutatud pildid

Naidete selgitamisel kasutatud pildid (Joonis 32)d garjestatud Uksteise peale.
Vasakpoolsem pilt oli jarjestatud parempoolse pidale. Seega kihtide kokkusobitamisel
l&htus Photoshop vasakpoolse pildi varvusinfost.

1. Screen

tumedad pikslid. Kuna pealmisel kihil paris muséaw piksleid palju ei olnud, vGime ndha
[6pptulemusel kumamas labi ka pealmise kihi tumeldmosi. Halltoonid loovad
l&bipaistvuse
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2. Overlay

Overlay on samuti Uks enimkasutatavanliend Mode Overlayalgoritm sailitab alumise
kihi heledusinfo ning varvid ning segab oma varaldmise kihi omadega. Pealmise kihi
tumedad osad muudavad alloleva kihi varvid tumedamsamal ajal pealmise kihi valged
osad helendavad alumist kihti.

3. Linear nght

Uks vahemtuntuddlend Mode Kui tlaloleva kihi varvi tumedus on alla 50% hadini siis
allolevat kihti helendatakse (valged kohad). Kualdleva kihi varvi tumedus on Ule 50%
halltooni siis allolevat kihti tumendatakse. Kurblav pilt oli vordlemisi tume siis selle
Blend Modé rakendamine suurendas kontrastsust.

4. Color

Uks objektide varvimiseks tihti kasutatBlend ModeTulem on mustvalge, kuna pealmine

kiht koosneb vaid halltoonidest ja algoritm asendkimise kihi pealmise kihi varviga.
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